MnPAVE User's Guide

July 2012

Minnesota Department of Transportation
# Table of Contents

Introduction .......................................................................................................................... 3  
Units .................................................................................................................................. 4  
Installing MnPAVE ............................................................................................................... 5  
Starting MnPAVE .................................................................................................................. 9  
Climate .............................................................................................................................. 11  
  Climate Details .................................................................................................................. 12  
Traffic ............................................................................................................................... 13  
Structure .......................................................................................................................... 14  
  Basic Structure ................................................................................................................ 15  
  Confidence Level ............................................................................................................ 16  
  Thickness Views ............................................................................................................. 17  
  Intermediate Structure .................................................................................................... 18  
  Advanced Structure ....................................................................................................... 18  
  Structure Views ............................................................................................................. 20  
Overlay Design ................................................................................................................ 22  
  Basic Overlay Design Procedure .................................................................................... 22  
  Intermediate Overlay Design Procedure ....................................................................... 24  
Output ............................................................................................................................ 27  
  Fatigue and Rutting Models ........................................................................................... 27  
  Initial Output .................................................................................................................. 28  
  Reliability ...................................................................................................................... 29  
  Reports ........................................................................................................................... 30  
  Basic Output .................................................................................................................. 30  
  Batch Mode ................................................................................................................... 31  
Research Mode ............................................................................................................... 32  
References ...................................................................................................................... 33  
Contact Information ........................................................................................................ 35
Introduction

MnPAVE is a computer program that combines known empirical relationships with a representation of the physics and mechanics behind flexible pavement behavior. The mechanistic portions of the program rely on finding the tensile strain at the bottom of the asphalt layer, the compressive strain at the top of the subgrade, and the maximum principal stress in the middle of the aggregate base layer.

MnPAVE consists of three input modules: Climate, Traffic, and Structure; and three design levels: Basic, Intermediate, and Advanced. The level is selected based on the amount and quality of information known about the material properties and traffic data. In the basic mode, only a general knowledge of the materials and traffic data are required. The intermediate level corresponds to the amount of data currently required for Mn/DOT projects. The advanced level requires the determination of modulus values for all materials over the expected operating range of moisture and temperature.

MnPAVE simulates traffic loads on a pavement using a Layered Elastic Analysis (LEA) called WESLEA. It is a five-layer isotropic system program written in 1987 by Frans Van Cauwelaert at the Catholic Superior Industrial Institute Department of Civil Engineering in Belgium and modified in 1989 by Don R. Alexander at the U.S. Army Engineer Waterways Experiment Station in Vicksburg, Mississippi. All layers are assumed to be isotropic in all directions and infinite in the horizontal direction. The fifth layer is assumed to be semi-infinite in the vertical direction. Material inputs include layer thickness, modulus, Poisson's ratio, and an index indicating the degree of slip between layers. MnPAVE assumes zero slip at all layer interfaces. Other inputs include load and evaluation locations. Loads are characterized by pressure and radius. The LEA program calculates normal and shear stress, normal strain, and displacement at specified locations.

MnPAVE output includes the expected life of the pavement, which is calculated using a damage factor based on Miner's Hypothesis. Reliability is estimated using Monte Carlo simulation. There is also a batch section for testing a range of layer thicknesses. In Research Mode (accessible from the "View" menu in the main MnPAVE window), output includes various pavement responses for each season.
Units

The default system of engineering units is English, however the system of units can be changed in any of the main modules. System International (SI) or English units may be selected.

<table>
<thead>
<tr>
<th>English</th>
<th>SI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td></td>
</tr>
<tr>
<td>1 in</td>
<td>25.4 mm</td>
</tr>
<tr>
<td>1 ft</td>
<td>0.3048 m</td>
</tr>
<tr>
<td>1 mi</td>
<td>1.609344 km</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 lb</td>
<td>4.448222 N</td>
</tr>
<tr>
<td>1 kip</td>
<td>1000 lbs</td>
</tr>
<tr>
<td>1 kip</td>
<td>4.448222 kN</td>
</tr>
</tbody>
</table>

Pressures (Modulus)

<table>
<thead>
<tr>
<th>1 psi</th>
<th>6.894757 kPa</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ksi</td>
<td>1000 psi = 6.894757 MPa</td>
</tr>
</tbody>
</table>
Installing MnPAVE

The installation file, Install_MnPAVE6200.exe, can be downloaded from the MnPAVE website: http://www.dot.state.mn.us/app/mnpave. Double click on and follow the instructions in the following installation windows:

1. The first Install window contains version and contact information.

![Install MnPAVE Window](image1)

MnPAVE Version 6.200
If you have any questions or comments, please contact:

Bruce Tanquist
Mn/DOT Office of M&RR MS 645
1400 Gervais Ave.
Maplewood, MN 55109

Tel. 651-366-5422
Fax 651-366-5461
E-mail: bruce.tanquist@state.mn.us

OK

2. Clicking "Setup" in the Winzip Self-Extractor window initiates the installation process.

![WinZip Self-Extractor Window](image2)

Click on "Setup" to install MnPAVE on your computer.
This window will remain a short time after setup.
Please wait
3. The Welcome window contains brief setup instructions.

![Welcome window](image1)

4. Update information is included in this window. This information can also be viewed at [http://www.dot.state.mn.us/app/mnpave/history.html](http://www.dot.state.mn.us/app/mnpave/history.html).

![Information window](image2)
5. The executable MnPAVE.exe and Help files will be placed in Program Files\MnDOT\MnPAVE unless a different location is specified.

6. A MnPAVE folder will be added to the Windows Menu, unless a different folder is specified.
7. Finish

At this point there will be a MnPAVE icon on the desktop and in the Windows menu under the folder name specified in Step 6.
Starting MnPAVE

The program can be started by double-clicking on the MnPAVE icon on the desktop or selecting MnPAVE from the Windows menu under the folder name specified in Step 6 of Installing MnPAVE.

At this point, the Main Control Panel is visible:

A new MnPAVE file can be opened by clicking on the icon or by selecting "New" from the "File" menu.

An existing MnPAVE file can be opened by clicking on the icon or by selecting "Open" from the file menu. A recently saved file can also be selected from the list at the bottom of the "File" menu.

Changes to the current file can be saved by clicking on the or by selecting "Save" from the "File" menu. Changes can be saved as a new file name by selecting "Save As" from the "File" menu.
# Project Information

Project information is a form for entering information necessary to identify a MnPAVE project. Mn/DOT District, county, city, highway, construction type, design engineer and project notes are entered in this module.

<table>
<thead>
<tr>
<th>District</th>
<th>County</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Crow Wing</td>
<td>All Counties</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Project No.</th>
<th>Route</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>CR1331</td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reference Post (RP)</th>
<th>Letting Date</th>
<th>Construction Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00 to 2.00</td>
<td>7/2/2012</td>
<td>2360</td>
<td></td>
</tr>
</tbody>
</table>

Designer: MnPAVE  
Soils Engineer: MnPAVE

Notes: (Type any project details here that should be documented in the report.)

Go Back to Control Panel  
View Mn/DOT Bituminous Specifications  
(Requires internet connection)
Climate

Climate contains a map of Minnesota where more specific location data can be entered. MnPAVE calculates season lengths and temperatures for each location using data from surrounding weather stations.

MnPAVE has five default seasons based on material properties measured at the Mn/ROAD research site throughout the year. Spring is divided into two seasons because of the drastic changes in aggregate base and subgrade soil properties during the Spring thaw period.

MnPAVE calculates the average pavement temperature for each season based on data from surrounding weather stations. Details of this calculation can be viewed in the Details window.

The county and district can be selected from menus in the Project Information window. Clicking on the map will also select them. The season lengths and average seasonal temperatures are shown in the left portion of the Climate window.

As the pointer moves over the map, the current district, county, and coordinates under the pointer are displayed to the left under Pointer Location. Click the left mouse button to select this location. The district and county can also be selected in Project Information.
Climate Details

Seasonal air and pavement temperatures can be viewed in this window.

The air temperature at the selected location is based on a weighted average of data from weather stations in a 75 mile (120 km) radius. Each seasonal air temperature value represents the average daily temperature for that season. The equation used to convert air temperature to pavement temperature can be seen by clicking the button.

Early Spring Thaw Depth is the assumed depth of the thawed/frozen interface during Early Spring. The thawed portion of the base and/or soil is assumed to have a high moisture content and low modulus. Seasonal modulus multipliers for the selected pavement materials can be viewed in Advanced Structure. If the thaw depth extends into a soil layer, then the Late Spring multiplier is used for the thawed portion of the soil.
Traffic

ESAL (Equivalent Single Axle Load) is a simplified measure of traffic for pavement design. An ESAL is defined as an 18 kip (80 kN) dual tire axle with a tire pressure of 80 psi (552 kPa). Other axle loads and configurations can be converted to ESALs by using Load Equivalency Factors (LEF) as defined in Appendix D of the 1993 AASHTO Guide for Design of Pavement Structures.

Lifetime ESALs are the number of ESALs expected during the number of years specified in Design Period Length.

The First Year value is calculated based on the Design Period Length and Growth Rate.

If only First Year ESALs are known, it can be entered here and Lifetime ESALs will be calculated based on the Design Period Length and Growth Rate.

The Design Period Length is typically 20 years.

The Annual Growth Rate determines the amount that traffic increases during each year of the Design Period. Traffic analysis conducted by Mn/DOT has indicated that a simple growth model is appropriate for most Minnesota routes (traffic increases by a fixed amount each year).

Note: In some windows, such as this one, the initial view shows only the details necessary for a basic pavement design. To view more details (as shown in this image), click the Show Details button.

Allowable Stress is used to protect against failure in the aggregate base layer due to a single heavy load event. For this reason, the axle weights in this window represent the heaviest axles expected. The default values for low-volume roads (less than 1,000,000 ESALs) are legal axle weights in Minnesota. Values used for higher traffic volumes are consistent with data from around the state.

<table>
<thead>
<tr>
<th>Axle Configuration</th>
<th>Wheel Spacing (in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tire Pressure</td>
<td>80 psi</td>
</tr>
<tr>
<td>Axle Weight</td>
<td>10 kips</td>
</tr>
<tr>
<td>Wheel Weight</td>
<td>4.5 kips</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ESALs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifetime</td>
</tr>
<tr>
<td>First Year</td>
</tr>
<tr>
<td>(Calculated)</td>
</tr>
<tr>
<td>Design Period Length</td>
</tr>
<tr>
<td>Annual Growth Rate (%)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
</tr>
<tr>
<td>SI</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Allowable Stress Failure Criterion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heaviest Single Tire Axle</td>
</tr>
<tr>
<td>Axle Weight (kips)</td>
</tr>
<tr>
<td>Tire Pressure (psi)</td>
</tr>
<tr>
<td>Wheel Spacing (in.)</td>
</tr>
</tbody>
</table>

| Heaviest Dual Tire Axle            |
| Axle Weight (kips)                | 20                   |
| Tire Pressure (psi)                | 100                  |
| Wheel Spacing (in.)                | 13.5                 |
Structure

When Structure is opened for the first time in a project, the **HMA Mix Properties** Window opens to make sure all mix design information is entered correctly. Mix design information such as asphalt binder content and gradation are required to estimate the HMA dynamic modulus. Currently, the selection of a binder grade serves only to document the binders used in the design. Only PG 58-28 data was available for the current MnPAVE calibration, so all HMA layers will have PG 58-28 properties regardless of the binder type selected.

Up to three HMA types can be defined for layer 1. Since the LEA procedure only allows five layers, multiple HMA layers are combined into a single layer using the equivalent thickness method.

Click on the colored bar to select a default gradation based on a Mn/DOT specification. A custom gradation can be defined by entering numbers in the “Percent Passing” edit boxes.

To view more details about how HMA modulus is calculated, click on the “Show Details” button and then the Advanced button next to each lift.

The Structural Number (SN) is calculated using the method described in Section 2.3.5 of the 1993 AASHTO Guide for Design of Pavement Structures.
Basic Structure

Basic Structure is intended for low-volume roads or designs that don’t require a high degree of reliability. MnPAVE uses default design modulus values. These modulus values are adjusted for seasonal variations in moisture and temperature.

Click on a layer button to select the number of layers in the pavement structure. The bottom layer is always semi-infinite. A MnPAVE pavement structure must have between two and five layers. Due to limitations in the LEA procedure, layer 5 cannot be analyzed for rutting. Therefore layers 2 through 4 must contain at least one engineered soil\(^1\) or undisturbed soil\(^2\) layer.

The Default Structures area provides shortcuts for several common pavement structures. Select the desired pavement structure, then adjust the layer thicknesses and material subtypes.

Material Types for each layer are selected on the left side of the Structure window under Edit Structure. Layers with a white pointer arrow can be clicked to select a different subtype. R-Value Design can be clicked to view the traditional MNDOT design results for this structure.

---

\(^1\) Soil that has been blended and compacted prior to construction.

\(^2\) Existing soil that has not been reworked. Because of uncertainty in the quality and uniformity of the material, the default undisturbed soil modulus is equal to half of the corresponding engineered soil modulus.
**Confidence Level**

This value is used to adjust layer thickness and modulus values to assure that a proportion of the pavement area meets or exceeds the desired values, based on the coefficient of variation (COV). The higher the confidence level and COV the more the value is reduced. A confidence level of 50% results in no reduction (the mean value is used in the simulation). The Confidence Level differs from the reliability value calculated in the Output Monte Carlo simulation. The Confidence Level reduces the values for all layers and acts as a factor of safety to account for variability and uncertainty. A Monte Carlo simulation should be run on the final design to determine reliability. In Design Mode, the Confidence Level is set at a default value of 70%. It is adjustable in Research Mode.
Thickness Views

Thickness Values Displays the design thickness. These values are adjusted based on the Thickness Coefficient of Variation (COV) for the simulation.

Thickness Coefficient of Variation indicates the variability of the thickness value of each layer.

\[
\text{COV} (\%) = \frac{\text{Standard Deviation}}{\text{Mean}} \times 100
\]

Adjusted Thickness Displays the reduced thickness used in the pavement simulation.
Intermediate Structure

**Intermediate Structure** has a form for entering test data for aggregate base and subgrade soils. These values are converted to design modulus and adjusted for seasonal variations. If no test has been performed on a given material, its box can be left unchecked to use default Basic material properties. Basic HMA data is used in this mode. A material subtype need not be selected if test data is entered. If the material subtype is known, it can be selected by clicking on the pointer arrow to the right of the edit box. If the material subtype is not known, select *Unknown* from the list. To view the calculated moduli, click on the *Advanced* tab.

If *Other* is selected in the *Edit Structure* area, material properties are edited in *Intermediate* or *Advanced Structure*.

---

**Advanced Structure**

**Advanced Structure** requires the input of design modulus values for every layer and every layer.

*Design Mode*: Click on Basic, Intermediate, or Advanced to view the corresponding material properties below. Selecting Basic or Intermediate displays values calculated based on data from those modules. In Advanced mode, all material properties must be entered manually.
The design mode is displayed above the “Finished” button to confirm that the correct mode is selected. Any editing that is done in the Basic, Intermediate, or Advanced windows will change the mode. If any editing causes the wrong mode to be selected, this can be corrected prior to clicking on the “Finished” button.

**Import Moduli**

These buttons appear in the Advanced Structure window when Advanced Mode is selected. Basic default modulus values can be imported into Advanced Mode when custom values are not available for all layers and seasons.
Structure Views

Structure views for all design levels can be viewed by clicking the Advanced tab.

**Design Modulus** displays design modulus values. For pavement simulations these values are adjusted according to the Confidence Level.

**Adjusted Modulus** indicates how values used in the pavement simulation are adjusted according to the Confidence Level.

**Poisson’s Ratio** is a measure of a material’s tendency to expand in the horizontal direction when it is compressed in the vertical direction. Poisson’s Ratio is used in Layered Elastic Analysis (LEA) simulations.

**Seasonal Modulus Multipliers** displays seasonal multipliers for each aggregate base, subbase, and soil material (HMA moduli are calculated for each season). Multipliers indicate moisture susceptibility and the state of the material (frozen or thawed).
**Modulus Coefficient of Variation (COV)** shows the expected variability in modulus for each layer along with the assumed distribution shape. This data is used to determine the adjusted modulus values used in the simulation and the data set used for the Monte Carlo simulation in Output.

The default modulus data used in MnPAVE fits a lognormal distribution (log-transformed data fits a normal distribution). The COV of this data is calculated as follows:

\[
COV = \sqrt{e^{\sigma^2}} - 1 \times 100
\]

Where

**COV** = Coefficient of Variation (%)

\(\sigma^2\) = variance of log-transformed data

<table>
<thead>
<tr>
<th>Parameter Shown Below</th>
<th>Structural Number = 2.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Modulus, ksi</td>
<td></td>
</tr>
<tr>
<td>Adjusted</td>
<td></td>
</tr>
<tr>
<td>Poisson's Ratio</td>
<td></td>
</tr>
<tr>
<td>Seasonal Modulus Multipliers</td>
<td></td>
</tr>
<tr>
<td>Modulus Coefficient of Variation, %</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fall</th>
<th>Winter</th>
<th>Early Spring</th>
<th>Late Spring</th>
<th>Summer</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>Lognorma</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>Lognorma</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>40</td>
<td>40</td>
<td>40</td>
<td>Lognorma</td>
</tr>
<tr>
<td>75</td>
<td>75</td>
<td>75</td>
<td>75</td>
<td>75</td>
<td>Lognorma</td>
</tr>
</tbody>
</table>
Overlay Design

While a complete Mechanistic-Empirical overlay design method has not yet been developed for MnPAVE, overlays can be designed using the conventional fatigue and rutting criteria to check for structural capacity. In addition, FWD\(^3\) deflections and the TONN method can be used to determine the necessary overlay thickness to avoid the need for Spring load restrictions.

Basic Overlay Design Procedure

While MnPAVE can check for fatigue, rutting, and shear failure in the aggregate base, these are often not the primary factors in determining overlay thickness. When designing overlays in Basic mode, the designer must also rely on other overlay design methods and guidelines. Do Project Information and Climate, and then go to Structure.

Select the default overlay structure. If the old HMA properties for this layer have not yet been defined, the HMA Mix Properties window will open up.

---

3 Falling-Weight Deflectometer: A device that measures deflections that result from a weight dropped onto the pavement. These deflections can be used to determine the modulus of the pavement layers.
If the HMA Mix Properties window did not open, click on the gray Old HMA subtype bar. Select the binder grade of the old HMA and any other mix properties that are known and click OK.

Check the Mill and Overlay checkbox if applicable (the old HMA thickness should be the thickness after milling).

Define the HMA properties for the new (overlay) HMA.

Define the other pavement layers to the extent that their material types and thicknesses are known.

Continue to Traffic and Output.

If this is a Mill and Overlay project, HMA fatigue and subgrade rutting results will be displayed. If it is not a Mill and Overlay project and rutting has been observed in the old HMA, check the Rutting is present in old HMA box. If rutting is not present in the existing HMA, it is not necessary to check for subgrade rutting.
Intermediate Overlay Design Procedure

Select material types and subtypes for the layers, with HMA overlay in layer 1 and Old HMA in layer 2.

Click on the Intermediate tab and select FWD Deflections.

The FWD Data window will open. FWD loads and deflections must be entered in the spreadsheet. Data entry is greatly simplified by opening the FWD deflection file in a spreadsheet such as Excel, cutting and pasting to put the data in the appropriate columns, and then pasting the data into MnPAVE.
Pavement temperature can be entered by two methods. If the pavement temperature is known, uncheck the checkbox and enter the known pavement temperature values in column 2. If the pavement temperature is not known, it can be estimated using the BELLS 3 method. Enter the previous day’s high and low air temperatures in the appropriate boxes and the infrared surface temperatures in column 2.

If Mill and Overlay was checked, the button must be clicked to define the old HMA thickness at the time of the FWD testing and after milling.

Annual Average Daily Traffic (AADT) must also be entered. If this value is not known, it can be estimated from the design ESALs and the road type by clicking on the button.

Select the soil plasticity at the bottom by clicking on the button. Clicking on the button toggles through three levels: Plastic, Semi-Plastic, and Non-Plastic. If this property is unknown, assume the soil is plastic.

The value is used in the TONN procedure. This value is typically 0.11 and ordinarily does not need to be changed.
Once all data has been entered, click on the **Calculate** button.

If BELLS3 was used, column 2 displays the estimated pavement temperatures at 1/3 of the pavement depth. Column 3 displays the fwd load, and column 4 displays the center deflection normalized to a 9 kip (40 kN) load (all deflections are normalized for the calculations). Column 5 displays the calculated HMA modulus and column 6 displays the Spring Load Restriction recommended by the TONN procedure for the selected overlay thickness. Column 7 displays the overlay thickness recommended by the TONN procedure. The mean and standard deviation for these values is displayed at the bottom of the table.
Output displays the expected life based on fatigue and rutting damage. Optimum layer thickness can be determined automatically in ESAL mode.

**Fatigue and Rutting Models**

The expected life of a pavement is calculated by simulating the strains due to traffic loads and using an empirical transfer function to determine the Allowed Repetitions\(^4\) for each load. If the applied load repetitions exceeds the allowed repetitions, the pavement is assumed to have failed.

\[ N_F = C_F K_F \varepsilon_{h} K_F E K_F \]

Where
- \( C_F \) = Correction factor
- \( K_F \) = Constant
- \( \varepsilon_{h} \) = Horizontal tensile strain at bottom of HMA (in/in)
- \( E \) = HMA Dynamic Modulus (psi)
- Use polymer shift factor for fatigue

\[ N_R = C_R K_R \varepsilon_{v} K_R \]

Where
- \( C_R \) = Correction factor
- \( K_R \) = Constant
- \( \varepsilon_{v} \) = Vertical compressive strain at top of subgrade (in/in)
- Use polymer shift factor for rutting

---

\(^4\) The number of repetitions of a given axle load that are assumed to cause pavement failure by fatigue cracking or rutting
Initial Output

Basic Output displays the expected years of pavement life based on calculated fatigue and rutting damage. The pavement damage is also expressed as a percent contribution by each season.

If fatigue or rutting values are too low or too high, Material subtypes and layer thicknesses can be adjusted. After each change “Recalculate” must be clicked to view the new results. For Basic designs, HMA and aggregate subtypes can be adjusted in Output. For Intermediate designs, only HMA can be adjusted in Output (other materials must be changed in Structure). In Advanced mode, all material types must be changed in Structure.

Thickness Goal Seek is a tool for determining design layer thicknesses in ESAL mode. To adjust the HMA layer only, select “Layer 1” and click on Thickness Goal Seek. A number of cycles will be executed until the pavement fails in neither fatigue nor rutting.

When Thickness Goal Seek is done for non-HMA layers, the HMA layer will be adjusted for fatigue first (if necessary), and then the selected layer will be adjusted. This is because adjusting underlying layers has a relatively small effect on fatigue life and may result in a large number of cycles and very thick layers.

After running Thickness Goal Seek, layer thicknesses can be adjusted manually to obtain the desired structure.
Reliability

Output reliability considers the variability of the thickness and modulus values for each layer to determine a reliability value for the pavement design.

The reliability will not necessarily agree with the confidence level selected in Structure because the confidence level selects the "worst case" thickness and modulus value for each layer while the reliability analysis considers a random combination of thickness and modulus values.

The number of Monte Carlo cycles can be adjusted by clicking the “Edit Cycles” button. A sensitivity analysis was conducted to determine the optimum value of 2500 cycles.

The “Run Quick Reliability” button uses equations derived from running a range of full Monte Carlo simulations to estimate the Monte Carlo reliability for a given structure. This is a time-saving feature that allows quick adjustments in the structure. Once the desired quick reliability value is reached a full Monte Carlo reliability should be run for verification.

The “Run Monte Carlo Simulation” button runs the selected number of Monte Carlo cycles. The time for this process ranges from less than one minute to a few minutes for an ESAL design (depending on the computer’s processor speed) and up to several hours for a load spectrum design.
Reports

A summary report can be saved as PDF file by clicking on the PDF icon or by selecting "PDF Design Summary" from the "File" menu.

A screen shot of the output window can be printed by clicking on the camera icon. Most other windows have a camera icon that can be clicked to print a screen shot.

Basic Output

Basic Output displays the expected years of pavement life based on calculated fatigue and rutting damage. The pavement damage is also expressed as a percent contribution by each season.

The relative damage effect from each season is displayed on the right side of the window. These values are affected by both the magnitude of strain that occurs during each season as well as the season length.

Results can be exported to a text file (comma or tab delimited) or to an “Excel” file. The Excel file is actually a tab delimited text file with an “xls” file extension. Double-clicking on this file opens it in Excel, but it must be “Saved As” Excel to convert it to true Excel format.

The Design Summary contains expected life and damage, project information, and limited structural and traffic information.

Damage Details includes more seasonal and traffic information.
Batch Mode

The batch mode allows the user to specify a range of layer thickness values and have all results tabulated in a text file or spreadsheet.

Check the box for each layer for which the thickness will be varied. Type the thinnest value in the "Begin" box, the thickest value in the "End" box, and the amount to increase the thickness in the "Incr." box. Damage Limits are used to exclude extremely over- or under-designed structures from the output file. When Set Frost-Free Depth is selected, each simulated structure will be adjusted so that the specified thickness of granular or better material is placed above the subgrade soil.

Selecting one of the output format buttons will prompt the user for a file name and then run the batch process.

The value under Batch Cycles is the number of structures that will be simulated. If Set Damage Limits is checked, the number of lines in the output file may be fewer than this value.
Research Mode

The standard design mode in MnPAVE provides the features necessary to complete a pavement design. Research Mode can be selected from the Main Control Panel from the View menu.

In Research Mode there are more features and more flexibility in entering data. However, since data entered in Research Mode may fall outside the range of date used to calibrate MnPAVE, Research Mode is not recommended for pavement design.
References

AASHTO (American Association of State Highway & Transportation Officials)
444 North Capitol Street N.W., Suite 249
Washington, DC 20001
Phone: (202) 624-5800
Fax: (202) 624-5806
Email: info@aashto.org
http://transportation.org/aashto/organization.nsf/allpages/AboutUs

WESLEA

“Illinois” Rutting Model

Asphalt Institute (Finn) Fatigue Model

Miner’s Hypothesis
Programming Acknowledgments

WESLEA (wes5)  Frans J. Van Cauwelaert
    Don R. Alexander
    Thomas D. White
    Walter R. Barker
    Bjorn Birgisson

Embedded Property Sheets  Eugene Kain

File Export Dialog (CFileExportDialog)  Anneke Sicherer-Roetman

Hyperlink (CHyperlink)  Giancarlo Iovino
    Chris Maunder

Image Tool Tips  Paul DiLascia

MFC Grid Control (CGridCtrl)  Chris Maunder

Printing Class Library  Richard Stringer

Round to Decimal  Corey Spagnoli
Contact Information

Bruce Tanquist
Assistant Pavement Design Engineer
Minnesota Department of Transportation
1400 Gervais Ave.
Mail Stop 645
Maplewood, MN  55109-2044
Phone:  651-366-5422
Fax:  651-366-5461
bruce.tanquist@state.mn.us
http://www.dot.state.mn.us/materials/pvmtdesign

LRRB (Minnesota Local Road Research Board)
Sandy McCully
Mn/DOT - Office of Investment Management
Research Services
Phone:  651-366-3768
sandy.mccully@state.mn.us
http://www.lrrb.org/

Mn/DOT State Aid for Local Transportation
395 John Ireland Boulevard
St.Paul, MN 55155-1899
Mail Stop 500
Phone:  651-366-3800
Fax:  651-366-3801
http://www.dot.state.mn.us/stateaid/